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How to Use this Book

“Introduction to GeoGebra” covers all basics of the dynamic mathematics
software GeoGebra. On the one hand, this book can serve as a basis for
introductory workshops guided by an experienced GeoGebra presenter. On the
other hand, you can use this document to learn the use of the software yourself.

By working through this book you will learn about the use of GeoGebra for
teaching and learning mathematics from middle school (age 10) up to college
level. The provided sequence of activities introduces you to geometry tools,
algebraic input, commands, and a selection of different GeoGebra features.
Thereby, a variety of different mathematical topics is covered in order to
familiarize you with the versatility of the software and to introduce you to some
methods of integrating GeoGebra into your everyday teaching.

Additionally, practice blocks are included in the structure of this introductory
book. They allow you to practice new skills learned before and to explore the
software on your own.

All construction files covered in this book, as well as accompanying files
(additional GeoGebra files, dynamic worksheets, picture files) are available
online at http://www.geogebra.org/book/intro-en.zip

We wish you a lot of fun and success working with GeoGebra!
Judith, Markus, and the GeoGebra Team
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1. Installation and Introduction of GeoGebra

Activity 1: Installing GeoGebra

Preparations

Create a new folder called GeoGebra_Introduction on your desktop.
Hint: During the workshop, save all files into this folder so they are easy to find
later on.

Installation WITH Internet Access

Install GeoGebra WebStart
e Open your Internet browser and go to www.geogebra.org/webstart.
e Click on the button called WebStart 4.0.
Note: The software is automatically installed on your computer. You only
need to confirm all messages that might appear with OK or YES.

Hint: Using GeoGebra WebStart has several advantages for you provided that
you have an Internet connection available for the initial installation:

¢ You don’'t have to deal with different files because GeoGebra is installed
automatically on your computer.

e You don't need to have special user permissions in order to use
GeoGebra WebStart, which is especially useful for computer labs and
laptop computers in schools.

e Once GeoGebra WebStart was installed you can use the software off-line
as well.

e Provided you have Internet connection after the initial installation,
GeoGebra WebStart frequently checks for available updates and installs
them automatically. Thus, you are always working with the newest version
of GeoGebra.

Installation WITHOUT Internet Access

¢ Your workshop presenter will provide the GeoGebra installer files via USB
drives or CDs.
e Copy the installer file from the storage device into the created
GeoGebra_Introduction folder on your computer
Hint: Make sure you have the correct version for your operating system
Examples: MS Windows: GeoGebra_4 0_0 0O.exe
MacOS: GeoGebra_4 0 0 _0.zip

e Double-click the GeoGebra installer file and follow the instructions of the
installer assistant.
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Activity 2: Save the Accompanying Files

Download the Accompanying Files and Save them on your Computer

e Your workshop presenter will provide the accompanying files via USB
drives or CDs. Copy the folder GeoGebra_Introduction_Files from the
storage device into the created GeoGebra_lIntroduction folder on your
computer.

OR

¢ Download the zipped file from www.geogebra.org/book/intro-en.zip

o Save the zipped file in your GeoGebra_Introduction folder.

o Extract the files on your computer. Depending on your operating
system there are different ways to do this:
Examples:
MS Windows XP: Right-click the zipped file and follow the
instructions of the Extraction Wizard.
MacQOS: Double click on the zipped file.

Introduction: What is GeoGebra and How Does it Work?

Background Information About GeoGebra

GeoGebra is dynamic mathematics software for schools that joins geometry,
algebra and calculus.

On the one hand, GeoGebra is an interactive geometry system. You can do
constructions with points, vectors, segments, lines, and conic sections as well as
functions while changing them dynamically afterwards.

On the other hand, equations and coordinates can be entered directly. Thus,
GeoGebra has the ability to deal with variables for numbers, vectors, and points.
It finds derivatives and integrals of functions and offers commands like Root or
Vertex.

These two views are characteristic of GeoGebra: an expression in the algebra
view corresponds to an object in the graphics view and vice versa.

GeoGebra’s User Interface

GeoGebra’s user interface consists of a graphics view, an algebra view and a
spreadsheet view. On the one hand you can operate the provided geometry tools
with the mouse in order to create geometric constructions in the graphics view.
On the other hand, you can directly enter algebraic input, commands, and
functions into the input bar by using the keyboard. While the graphical
representation of all objects is displayed in the graphics view, their algebraic
numeric representation is shown in the algebra view.
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The user interface of GeoGebra is flexible and can be adapted to the needs of
your students. If you want to use GeoGebra in early middle school, you might
want to hide the algebra view, input bar, and coordinate axes and just work with
the graphics view and geometry tools. Later on, you might want to introduce the
coordinate system using a grid to facilitate working with integer coordinates. In
high school, you might want to use algebraic input in order to guide your students
through algebra on into calculus.

Basic Use of Tools

e Activate a tool by clicking on the button showing the corresponding icon.

¢ Open a toolbox by clicking on the lower part of a button and select another
tool from this toolbox.
Hint: You don’t have to open the toolbox every time you want to select a
tool. If the icon of the desired tool is already shown on the button it can be
activated directly.
Hint: Toolboxes contain similar tools or tools that generate the same type
of new object.

e Check the toolbar help in order to find out which tool is currently activated
and how to operate it.

2. Drawing versus Geometric Construction

Activity 3: Drawing Geometric Figures and Other Objects

Preparations

e (o to Perspectives — Geometry.

Drawing Pictures with GeoGebra

Use the mouse and the following selection of tools in order to draw figures in the
graphics view (e.g. square, rectangle, house, tree,...).
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A New Point

°
% Move
/'/ Line Through Two Points
e Segment Between Two Points
v Delete Object
@  Undo / Redo Buttons
< Move Graphics View
®, S Zoom In/Zoom Out

New!

New!

New!

New!

New!

New!

New!

New!

What to practice

e How to select an already existing object.

Hint: When the pointer hovers above an object, it highlights and the
pointer changes its shape from a cross to an arrow. Clicking selects the

corresponding object.

e How to create a point that lies on an object.
Hint: The point is displayed in a light blue color. Always check if the point
really lies on the object by dragging it with the mouse.

e How to correct mistakes step-by-step using the Undo and Redo buttons.

Tip: Several tools allow the creation of points “on the fly”. Therefore, no existing

objects are required in order to use the tool.

Example: The tool Segment Between Two Points can be applied to two already
existing points or to the empty graphics view. By clicking on the graphics view the
corresponding points are created and a segment is drawn in between them.

Activity 4: Saving GeoGebra Files

Save your drawing
Open the File menu and select Save.

Type in a name for your GeoGebra file.
Click Save in order to finish this process.

Hint: A file with the extension ‘.ggb’ is created. This extension identifies
GeoGebra files and indicates that they can only be opened with GeoGebra.

Hint: Name your files properly: Avoid using spaces or special symbols in a file
name since they can cause unnecessary problems when transferred to other

10

Select the folder GeoGebra_Introduction in the appearing dialog window.
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computers. Instead you can use underscores or upper case letters within the file
name (e.g. First_Drawing.ggb).

What to practice

e How to open a new GeoGebra window using New Window from the File
menu.
e How to open a blank GeoGebra interface within the same window (menu
File — New)
Hint: If you didn’t save the existing construction yet GeoGebra will ask you
to do so before the blank screen is opened.
e How to open an already existing GeoGebra file (menu File — Open).
o Navigate through the folder structure in the appearing window.
o Select a GeoGebra file (extension ‘.ggb’).
o Click Open.

Activity 5: Drawings, Constructions and Drag Test
Open the dynamic worksheet A05 Drawing Construction Squares.html.

Squares, Squares, Squares,...

Below you can see six squares - or do they just look like squares?
1. Drag the vertices of each square with the mouse and write down what you can observe.
2. Try to come up with a canjecture about how each square was created and write it down

SquareA SquareB SquareC

uareD SquareE SquareF

The dynamic figure shows several squares constructed in different ways.
e Examine the squares by dragging ALL their vertices with the mouse.
e Find out which of the quadrilaterals real squares are and which ones just
happen to look like squares.
e Try to come up with a conjecture about how each square was created.
e Write down your conjectures on paper.

Discussion

e What is the difference between a drawing and a construction?

e What is the “drag test” and why is it important?

e Why is it important to construct figures instead of just drawing them in
interactive geometry software?

¢ What do we have to know about the geometric figure before we are able
to construct it using dynamic mathematics software?

11
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Activity 6: Rectangle Construction

Preparations

Summarize the properties of a rectangle before you start the construction.
Hint: If you don’t know the construction steps necessary for a rectangle
you might want to open the file AO6_Rectangle Construction.qggb. Use the
buttons of the navigation bar in order to replay the construction steps.
Open new GeoGebra file.

Switch to Perspectives - Basic Geometry.

Change the labeling setting to New Points Only (menu Options —
Labeling).

Introduction of New Tools

Perpendicular Line and Parallel Line Tools

Hint: Click on an already existing line and a point in order to create a
perpendicular line / parallel line through this point.

Intersect Two Objects Tool

Hint: Click on the intersection point of two objects to get this one
intersection point. Successively click on both objects to get all intersection
points.

Polygon Tool

Hints: Click on the graphics view or already existing points in order to
create the vertices of a polygon. Connect the last and first vertex to close
the polygon! Always connect vertices counterclockwise!

Hint: Don’t forget to read the toolbar help if you don’t know how to use a tool.
Hint: Try out all new tools before you start the construction.

12
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Construction Steps

1 | o~ |SegmentAB

2 - Perpendicular line to segment AB through point B
3 .":‘ New point C on perpendicular line

4 | Parallel line to segment AB through point C

5 #:-.,If Perpendicular line to segment AB through point A
6 >( Intersection point D

7 = Polygon ABCD

Hint: To close the polygon click on the first vertex again.

8 @ Save the construction

Check your Construction

1. Apply the drag test to check if the construction is correct.
2. Show the Navigation bar for construction steps (View menu) to review
your construction step-by-step using the buttons.
3. Show the Construction protocol (View menu) and use it to review your
rectangle construction step-by-step.
o Try to change the order of some construction steps by dragging a
line with the mouse. Why does this NOT always work?
o Group several constructions steps by setting breakpoints:
e Show the column Breakpoint (Right click on the construction
protocol window Columns - Breakpoint)
e Group construction steps by checking the Breakpoint box of
the last one of the group
e Change setting to Show Only Breakpoints (Right click on the
construction protocol window Options — Show Only
Breakpoints)
e Use the navigation bar to review the construction step-by-
step. Did you set the breakpoints correctly?

13
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Activity 7: Equilateral Triangle Construction

Preparations

e Summarize the properties of an equilateral triangle before you start the
construction.
Hint: If you don’t know the construction steps necessary for an equilateral
triangle you might want to have a look at the following file:
AO07 Equilateral _Triangle Construction.ggb. Use the buttons of the
navigation bar in order to replay the construction steps.

e Open a new GeoGebra window.

e Hide algebra view, input bar and coordinate axes (View menu).

¢ Change the labeling setting to New points only (menu Options — Labeling).

Introduction of New Tools

e Circle With Center Through Point tool

Hint: First click creates center, second click determines radius of the
circle.

Show / Hide Object tool

Hints: Highlight all objects that should be hidden, then switch to another
tool in order to apply the visibility changes!

Angle tool

Hint: Click on the points in counterclockwise direction! GeoGebra always
creates angles with mathematically positive orientation.

Hint: Don’t forget to read the toolbar help if you don’t know how to use a tool.
Hint: Try out all new tools before you start the construction.

14
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Construction Steps

1 Segment AB

O]

2 Circle with center A through B

Hint: Drag points A and B to check if circle is connected to them.

@.

Circle with center B through A

Hint: Drag points to check if circle is connected to them.

Intersect both circles to get point C

Polygon ABC in counterclockwise direction

Hide circles

N | o o] b~

.2‘\. - 1__;)' X

Show interior angles of triangle

Hint: Click in the middle of the polygon to create all interior angles!

8 F‘ﬂ Save the construction

Check your Construction

1. Apply the drag test to check if the construction is correct.
2. Show the navigation bar or use the construction protocol to review your
construction step-by-step.

Use the Properties Dialog to Enhance your Construction

There are different ways to access the Properties dialog:
¢ Right-click (MacOS: Ctrl-click) an object
e Select Object Properties... from the Edit menu
e Double click an object in Move mode
e Toggle Styling Bar on the right hand side of the graphics view
What to practice...
o Select different objects from the list on the left hand side and explore the
available properties tabs for different types of objects
e Select several objects in order to change a certain property for all of them
at the same time
Hint: Hold the Cirl-key (MacOS: Open Apple-click) pressed and select all
desired objects.
e Select all objects of one type by clicking on the corresponding heading.
e Show the value of different objects and try out different label styles.

15
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3. Practice Block |

This practice block consists of a pool of geometry activities of two different
difficulty levels: Basic tasks and Advanced tasks. You can pick tasks of your
interest and work on them either on your own or together with a colleague.

Tips and Tricks

Summarize the properties of the geometric figure you want to create.

Try to find out which GeoGebra tools can be used in order to construct the
figure using some of these properties (e.g. right angle — tool Perpendicular
line).

Make sure, you know how to use each tool before you begin the
construction. If you don’t know how to operate a certain tool, activate it
and read the toolbar help.

For each of these activities, open a new GeoGebra file, hide the algebra
view, input bar and the coordinate axes.

You might want to save your files before you start a new activity.

Don'’t forget about the Undo and Redo buttons in case you make a
mistake.

Frequently use the Move tool in order to check your construction (e.g. are
objects really connected, did you create any unnecessary objects).

If you have questions, please ask a colleague before you address the
presenter or assistant(s).

16
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Activity l.a: Square Construction

Classification: Basic task

In this activity you are going to use the following tools. Make sure you know how
to use each tool before you begin with the actual construction of the square:

Segment Between Two Points

:}: Polygon
&

Perpendicular Line Show / Hide Object

Circle With Center Through Point % Move

Intersect Two Objects

Hint: You might want to have a look at the file A_71a_Square Construction.html if

you are not sure about the construction steps.

Construction Steps

N~ WN =~

9.

Draw segment a = AB between points A and B

Construct perpendicular line b to segment AB through point B
Construct circle ¢ with center B through point A

Intersect circle ¢ with perpendicular line b to get intersection point C
Construct perpendicular line d to segment AB through point A
Construct circle e with center A through point B

Intersect perpendicular line d with circle e to get intersection point D
Create polygon ABCD.

Hint: Don’t forget to close the polygon by clicking on point A after selecting
point D.

Hide circles and perpendicular lines

10.Perform the drag test to check if your constructlon is correct

a b
DI 'C
- &~ e - R

A 3 B
h ]

Challenge: Can you come up with a different way of constructing a square?

17
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Activity I.b: Regular Hexagon Construction

Classification: Basic task

In this activity you are going to use the following tools. Make sure you know how
to use each tool before you begin with the actual construction of the hexagon:

@ Circle With Center Through Point
>-\/ Intersect Two Objects

.
o~ Polygon

&

s

Angle
Show / Hide Object

Move

Hint: You might want to have a look at the file A_71b_Hexagon Construction.html

if you are not sure about the construction steps.

Construction Steps

©CENOORWN =

10.Draw hexagon FGECBD.
11. Create the angles of the hexagon.

Draw a circle with center A through point B
Construct another circle with center B through point A

Intersect the two circles in order to get the vertices C and D.
Construct a new circle with center C through point A.

Intersect the new circle with the first one in order to get vertex E.
Construct a new circle with center D through point A.

Intersect the new circle with the first one in order to get vertex F.
Construct a new circle with center E through point A.

. Intersect the new circle with the first one in order to get vertex G.

12.Perform the drag test to check if your construction is correct.

Challenge: Try to find an explanation for this construction steps.
Hint: Which radius do the circles have and why?

18
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Activity l.c: Circumscribed Circle of a Triangle

Classification: Advanced task

In this activity you are going to use the following tools. Make sure you know how
to use each tool before you begin with the actual construction of the
circumscribed circle:

=
E

RN
M,

<
e

—» Circle With Center Through
Polygon @ ot g
Perpendicular Bisector New! [y Move

Intersect Two Objects

Hint: If you are not sure about the construction steps, you might want to have a
look at the file A_1c Circumcircle Triangle Construction.html.

Construction Steps

1.
2.

3.

Create an arbitrary triangle ABC

Construct the line bisector for each side of the triangle.

Hint: The tool, Line bisector, can be applied to an existing segment.
Create intersection point D of two of the line bisectors

Hint: The tool, Intersect two objects, can’t be applied to the intersection of
three lines. Either select two of the three line bisectors successively, or
click on the intersection point and select one line at a time from the
appearing list of objects in this position.

Construct a circle with center D through one of the vertices of triangle ABC
Perform the drag test to check if your construction is correct.

Challenge: Modify your construction to answer the following questions:

1.

2.

Can the circumcenter of a triangle lie outside the triangle? If yes, for which
types of triangles is this true?

Try to find an explanation for using line bisectors in order to create the
circumcenter of a triangle.

19
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Activity I.d: Visualize the Theorem of Thales

Classification: Advanced task

Before you begin this construction, check out the dynamic worksheet called
04 Theorem Thales.html in order to see how students could rediscover what
Thales found out about 2600 years ago.

In this activity you are going to use the following tools. Make sure you know how
to use each tool before you begin with the actual construction:

«  Segment Between Two Points :“a Polygon
fﬁ' Semicircle Through Two Points  New! 1= Angle
o’ New Point i Move

Hint: If you are not sure about the construction steps, you might want to have a
look at the file A_1d Theorem Thales Construction.html.

Construction Steps

1. Draw segment AB

2. Construct a semicircle through points A and B
Hint: The order of clicking points A and B determines the direction of the
semicircle.

3. Create a new point C on the semicircle

Hint: Check if point C really lies on the arc by dragging it with the mouse.

Create triangle ABC

Create the interior angles of triangle ABC

oA

Challenge: Try to come up with a graphical proof for this theorem.
Hint: Create midpoint O of segment AB and display the radius OC as a segment.

20
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4. Basic Algebraic Input, Commands and Functions

Tips and Tricks

Name a new object by typing name = into the input bar in front of its
algebraic representation. Example: P = (3, 2) creates point P.
Multiplication needs to be entered using an asterisk or space between
the factors. Example: a*x ora x

GeoGebra is case sensitive! Thus, upper and lower case letters must
not be mixed up. Note:

o Points are always named with upper case letters

Example: »n = (1, 2)
o Vectors are named with lower case letters
Example: v = (1, 3)
o Segments, lines, circles, functions... are always named with lower
case letters.
Example: circlec: (x - 2)%2 + (y - 1)"2 = 16

o The variable x within a function and the variables x and y in the

equation of a conic section always need to be lower case.

Example: f (x) = 3*x + 2
If you want to use an object within an algebraic expression or
command you need to create the object prior to using its name in the input
bar. Examples:

oy = m x + b creates a line whose parameters are already

existing values m and b (e.g. numbers / sliders).

o Line[A, B] creates a line through existing points A and B.
Confirm an expression you entered into the input bar by pressing the
Enter key.

Open the help window for using the input bar and commands by
selecting Help from the Menu Help (or shortcut F1).

Error messages: Always read the messages — they could possibly help to
fix the problem!

Commands can be typed in or selected from the list 0 next to the input
bar.
Hint: If you don’t know which parameters are required within the brackets
of a certain command, type in the full command name and press key F17 to
open the GeoGebra Wiki.
Automatic completion of commands: After typing in the first two letters
of a command into the input bar, GeoGebra tries to complete the
command.
o If GeoGebra suggests the desired command, hit the Enter key in
order to place the cursor within the brackets.
o If the suggested command is not the one you wanted to enter, just
keep typing until the suggestion matches.

21
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Activity 8a: Constructing Tangents to a Circle (Part 1)

Back to School...

Open the dynamic worksheet A08 Tangents Circle.html. Follow the directions
on the worksheet in order to find out how to construct tangents to a circle.

Constructing Tangents to a Circle

1. Use the arrow buttons in the figure below to
review the construction process of tangents to E T;:‘ztsD(régc?rsmm
a circle.

2 Tryto do this construction on your
own using the figure to the right.

3. Write down a construction protocol and

explain every construction step.

@

Ce ool o]

Discussion

e Which tools did you use in order to recreate the construction?

o Were there any new tools involved in the suggested construction steps? If
yes, how did you find out how to operate the new tool?

¢ Did you notice anything about the toolbar displayed in the right applet?

e Do you think your students could work with such a dynamic worksheet and
find out about construction steps on their own?

Activity 8b: Constructing Tangents to a Circle (Part 2)

What if my Mouse and Touchpad wouldn’t work?

Imagine your mouse and / or touchpad stop working while you are preparing
GeoGebra files for tomorrow’s lesson. How can you finish the construction file?

GeoGebra offers algebraic input and commands in addition to the geometry
tools. Every tool has a matching command and therefore could be applied
without even using the mouse.

Note: GeoGebra offers more commands than geometry tools. Therefore, not
every command has a corresponding geometry tool!

22
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Task 1: Check out the list of commands next to the input bar and look for
commands whose corresponding tools were already introduced in this workshop.

As you saw in the last activity, the construction of tangents to a circle can be
done by using geometric construction tools only. You will now recreate this
construction by just using keyboard input.

Preparations

e Open a new GeoGebra window.
e Show the algebra view and input bar, as well as coordinate axes (View
menu)

Construction Steps

1 |A = (0, 0) Point A

2 | (3, 0) Point B

Hint: If you don’t specify a name objects are named
in alphabetical order.

3 |c = Circle[A, B] | Circle with center A through point B

Hint: Circle is a dependent object

Note: GeoGebra distinguishes between free and dependent objects. While free
objects can be directly modified either using the mouse or the keyboard,
dependent objects adapt to changes of their parent objects. Thereby, it is
irrelevant in which way (mouse or keyboard) an object was initially created!

Hint 1: Activate Move mode and double click an object in the algebra view in
order to change its algebraic representation using the keyboard. Hit the Enter key
once you are done.

Hint 2: You can use the arrow keys in order to move free objects in a more
controlled way. Activate Move mode and select the object (e.g. a free point) in
either window. Press the up / down or left / right arrow keys in order to move the
object into the desired direction.

4 |C = (5, 4) Point C
5 |s = Segment[A, C] | SegmentAC
6 |D = Midpoint[s] Midpoint D of segment AC
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7 |d = Circle[D, C] Circle with center D through point C

8 | Intersect[c, d] Intersection points E and F of the two circles
9 |Line[C, E] Tangent through points C and E

10 | Line[C, F] Tangent through points C and F

B
B
®

~-@ a:1.05x - 5.56y = -16.97 L s,
3 b:5.19x-2.25y = 16.97 v~ “fe
cBeixieyi=9 4

LG d:(x—25)2 4+ (y—2)? =10.25
3 5=6.4

Checking and Enhancing the Construction

e Perform the drag-test in order to check if the construction is correct.

e Change properties of objects in order to improve the construction’s
appearance (e.g. colors, line thickness, auxiliary objects dashed,...)

e Save the construction.

Discussion

¢ Did any problems or difficulties occur during the construction steps?

¢ Which version of the construction (mouse or keyboard) do you prefer and
why?

¢ Why should we use keyboard input if we could also do it using tools?
Hint: There are commands available that have no equivalent geometric
tool.

¢ Does it matter in which way an object was created? Can it be changed in
the algebra view (using the keyboard) as well as in the graphics view
(using the mouse)?
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Activity 9: Exploring Parameters of a Quadratic Polynomial

Back to school...

In this activity you will explore the impact of parameters on a quadratic
polynomial. You will experience how GeoGebra could be integrated into a
‘traditional’ teaching environment and used for active, student-centered learning.

Follow the instructions on the paper worksheet and write down your results and
observations while working with GeoGebra. Your notes will help you during the
following discussion of this activity.

Exploring Parameters of a Quadratic Polynomial
1. Open a new GeoGebra window

2. Type in f(x) = x*2 and hit the Enter key. Which shape does the function
graph have? Write down your answer on paper.

3. In % Move mode, highlight the polynomial in the algebra view and use
the 1 up and | down arrow keys.
a. How does this impact the graph of the polynomial? Write down
your observations.
b. How does this impact the equation of the polynomial? Write down
your observations.

4. Again, in Move mode, highlight the function in the algebra view and use
the — left and — right arrow keys.
a. How does this impact the graph of the polynomial? Write down
your observations.
b. How does this impact the equation of the polynomial? Write down
your observations.

5. In Move mode, double click the equation of the polynomial. Use the
keyboard to change the equation to f(x) = 3 x*2.
Hint: Use an asterisk * or space in order to enter a multiplication.
a. Describe how the function graph changes.
b. Repeat changing the equation by typing in different values for
the parameter (e.g. 0.5, -2, -0.8, 3). Write down your
observations.
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Discussion

¢ Did any problems or difficulties concerning the use of GeoGebra occur?

e How can a setting like this (GeoGebra in combination with instructions on
paper) be integrated into a ‘traditional’ teaching environment?

e Do you think it is possible to give such an activity as a homework problem
to your students?

¢ In which way could the dynamic exploration of parameters of a polynomial
possibly affect your students’ learning?

¢ Do you have ideas for other mathematical topics that could be taught in
similar learning environment (paper worksheets in combination with
computers)?

Activity 10: Using Sliders to Modify Parameters

Let's try a more dynamic way of exploring the impact of a parameter on a
polynomial £ (x) = a x"2 by using a slider to modify the parameter value.

Preparation

e Open a new GeoGebra window
e Switch to Perspectives — Algebra & Graphics

Construction Steps

1]la=1 Create the variable a

2 | £(x) = a * x*2 | Enter the quadratic polynomial f

Hint: Don’t forget to enter an asterisk * or space
between a and x"2.

Representing a Number as a Slider

To display number as a slider in the graphics view you need to right click
(MacOS: Ctrl-click) the variable in the algebra view and select Show object.

Enhancing the Construction

Let's create another slider b that controls the constant in the polynomial’s
equation £ (x) = a x*2 + b.

3 232 Create a slider b using the Slider tool

Hint: Activate the tool and click on the graphics
view. Use the default settings and click Apply.
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4 | £(x) = a * x*2 + b | Enter the polynomial f

Hint: GeoGebra will overwrite the old function f
with the new definition.

Tasks

¢ Change the parameter value a by moving the point on the slider with the
mouse. How does this influence the graph of the polynomial?

e What happens to the graph when the parameter value is (a) greater than
1, (b) between 0 and 1, or (c) negative? Write down your observations.

e Change the parameter value b. How does this influence the graph of the
polynomial?

Activity 11: Library of Functions

Apart from polynomials there are different types of functions available in
GeoGebra (e.g. trigonometric functions, absolute value function, exponential
function). Functions are treated as objects and can be used in combination with
geometric constructions.

Note: Some of the functions available can be selected from the menu next to the
input bar. Please find a complete list of functions supported by GeoGebra in the
GeoGebra Wiki (http://wiki.geogebra.org/en/).

Task 1: Visualizing absolute values

Open a new GeoGebra window. Make sure the algebra view, input bar and
coordinate axes are shown.

1 | £(x)

abs (x) Enter the absolute value function f

2 |g(x) =3 Enter the constant function g

Intersect both functions
3 >( Hint: You need to intersect the functions twice in
order to get both intersection points.

Hint: You might want to close the algebra view and show the names and values
as labels of the objects.
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f(x) = abs(x) 61

A=(-3,3) B=(3 3)

9(x) =3

(a) Move the constant function with the mouse or using the arrow keys. The y-
coordinate of each intersection point represents the absolute value of the x-
coordinate.

(b) Move the absolute value function up and down either using the mouse or the
arrow keys. In which way does the function’s equation change?

(c) How could this construction be used in order to familiarize students with the
concept of absolute value?

Hint: The symmetry of the function graph indicates that there are usually two
solutions for an absolute value problem.

Task 2: Superposition of Sine Waves

Sound waves can be mathematically represented as a combination of sine
waves. Every musical tone is composed of several sine waves of the form
y(t)=asin(awt + @) . The amplitude a influences the volume of the tone while the

angular frequency w determines the pitch of the tone. The parameter ¢ is called
phase and indicates if the sound wave is shifted in time.

If two sine waves interfere, superposition occurs. This means that the sine waves
amplify or diminish each other. We can simulate this phenomenon with
GeoGebra in order to examine special cases that also occur in nature.

1 al? Create three slidersa_ 7, w_1,and ¢_1

Hints: a 1 produces an index. You can select
the Greek letters from the menu next to the
text field name in the Slider dialog window.

2 |g(x)=a_1sin(w_1x+¢_1) | Enterthe sine function g

Hint: Again, you can select the Greek letters
from a menu next to the input bar.
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(@)  Examine the impact of the parameters on the graph of the sine functions
by changing the values of the sliders.

Create three sliders a_2, w_2,and ¢_2
3 232 Hint: Sliders can only be moved when the
Slider tool is activated.

4 |h(x)=a_2sin(w_2x+¢_2) | Enter another sine function h

5 | sum(x) = g(x) + h(x) Create the sum of both functions

(b)  Change the color of the three functions so they are easier to identify.

(c) Setas=1, ws =1, and ¢4 = 0. For which values of a,, w2, and @, does the
sum have maximal amplitude?

Hint: In this case the resulting tone has the maximal volume.

(d)  For which values of a,, w,, and ¢, do the two functions cancel each other?
Hint: In this case no tone can be heard any more.

a1=2 a, =1

w1=1 | W, =1

9,;=0 (p2=0

sum
2
h- ‘ T '| T T 0
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5. Export of Pictures to the Clipboard

GeoGebra’s graphics view can be exported as a picture to your computer's
clipboard. Thus, they can be easily inserted into text processing or presentation
documents allowing you to create appealing sketches for tests, quizzes, notes or

mathematical games.

Activity 12a: Exporting Pictures to the Clipboard

Create your Sketch

Open a new GeoGebra window and make sure the algebra view, input bar and

coordinate axes are shown.

1 | £(x) =0.5x3+2x?+0.2x-1

Enter the cubic polynomial f

2 |R = Root[ £ ]

Create the roots of polynomial f

Hint: If there are more than one root
GeoGebra will produce indices for their
names if you type in R = (e.g. Ry, Rz, R3).

3 |E = Extremum[ f ]

Create the extrema of polynomial f

4 O

Create tangents to fin E; and E;

(6)]
H
Il

InflectionPoint[ £ ]

Create the inflection point of polynomial f

Hint: You might want to change properties of objects (e.g. color of points, style of
the tangents, show name and value of the function).

-2
f(x)=05x+2x+02x-1
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Exporting a Picture to the Clipboard

GeoGebra will export the whole graphics view into the clipboard. Thus, you need
to make the GeoGebra window smaller in order to reduce unnecessary space on
the graphics view:

e Move your figure (or the relevant section) to the upper left corner of the
graphics view using the % Move Graphics View tool (see left figure
below).

Hint: You might want to use tools ®& Zoom In and =\ Zoom Out in order to
prepare your figure for the export process.

¢ Reduce the size of the GeoGebra window by dragging its lower right
corner with the mouse (see right figure below).

Hint: The pointer will change its shape when hovering above an edges or
corner of the GeoGebra window.

€ Geolebra - cubic_polynomial.ggh o [E=]T=0]
File Edit Vi ves ind

o [

e~

00=0.53 + 22+ 0.2x-1

00=0.5C + 25¢ + 0.2x-1

GeoGebra window before GeoGebra window after
the size reduction the size reduction

Use the File menu to export the graphics view to the clipboard:
e Export — Graphics view to Clipboard
Hint: You could also use the key combination Ctrl — Shift — C.
e Your figure is now stored in your computer’s clipboard and can be inserted
into any word processing or presentation document.
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Edit View Perspectives Options Tools Window Help
E, MNew Window |

Mew

B Open ..
B Open Webpage ...
Open Recent LA

Save

Save As .

Share..

y [«

Export [ F Dynamic Worksheet as Webpage (himl) ...
) ) @ Graphics View as Picture (png, eps) ..
Print Preview

Graphics View as Animated GIF .

Close [-] Graphics View to Clipboard

© B

Graphics View as PSTricks ..
Graphics View as PGFITIikZ ..

Graphics View as Asymptote .

Activity 12b: Inserting Pictures into a Text Processing Document

After exporting a figure from GeoGebra into your computer’s clipboard you can
now paste it into a word processing document.

Inserting pictures from the clipboard to MS Word

¢ Open a new text processing document

e From the Home tab select Paste. The picture is inserted at the position of
the cursor.
Hint: You can use the key combination Ctrl — V instead.

Home Insert Page Layout References Mailings Review View
Calibri "1l v A AT Aa | S-S | EEEE 2] 9
- * . AL E=E=E= = -
# Format Painter LI - = = = = | =
Clipboard Fant Paragraph

Reducing the size of pictures in MS Word

If necessary you can reduce the size of the picture in MS Word:
e Double click the inserted picture.
¢ Change the height/width of the picture using the Size group on the right.
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Home Insert Page Layout References Mailings Review View | Format |
i Brightness = ;5{ Compress Pictures ‘_ DT 7 L =] 3
' L Dashes
(J Contrast = ‘E Reset Picture B30, - -
Shadow 0 Picture gight Position Wrap Send Selectio
g Recolor = Effects ™ 4 Borde ) *  Textv Forward~ Backward
Adjust Shadow Effects Baorder Arrange

Note: If you change the size of a picture, the scale is modified. If you want to
maintain the scale (e.g. for your students to measure lengths) make sure the size
of the picture is 100%.

Note: If a picture is too big to fit on one page MS Word will reduce its size
automatically and thus, change its scale.

Inserting pictures from the clipboard to OO Writer

¢ Open a new text processing document
e From the Edit menu select Paste or use the key combination Ctrl — V.

| |
Eile m View Insert Format Table Tools Window Help Picture P

Can't Undo Type |Options |Wrap [Hyperlink | Picture |Crop | Borders |Background |Macro |
Can't Restore Size Anchor
Repeat Width 17,00cm |2 0 To page
Cut [ Relative @ To paragraph
Cut

Height 1403cm |2 ©) To character

Copy

- Relative () As character
Gg  Paste [ Rel o=

Keep ratio

Paste Special...
Calar
Select Text Original Size
Selection Mode 3
[El SelectAl Position
Changes N Horizontal From left by 040cm |5 to Paragraph area |z|
Compare Document... [] Mirror on even pages

ﬁ Find 8 Replace...

n‘p\c AutoText...

[ Follow text flow

@ Exchange Database...

Fields...

[ QK ” Cancel H Help H Reset ]

Footnote/Endnote,..
Index Entry...
Bibliography Entry...
Hyperlink
Links...

)ﬁ’ Plug-in

ImageMap

Object

Reducing the size of pictures in OO Writer

Double click the inserted picture.

Select the Type tab in the appearing Picture window.
Change width/height of the picture.

Click OK.
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6. Practice Block Il

This practice block consists of a pool of activities to practice using algebraic
input, commands, and functions in GeoGebra. Activities of two different difficulty
levels are available: Basic tasks and Advanced tasks. You can pick tasks of your
interest and work on them either on your own or together with a colleague.

Tips and Tricks

For each of these activities, open a new GeoGebra file. Check prior to
beginning the activity if you need to show or hide the algebra view, input
bar and coordinate axes.

You might want to save your files before you start a new activity.

Don’t forget about the Undo and Redo buttons in case you make a
mistake.

Frequently use the Move tool in order to check your construction (e.g. are
objects really connected, did you create any unnecessary objects).

Make sure you know the syntax to enter algebraic expressions and
functions. Read through the Tips and Tricks section in the beginning of
topic Basic Algebraic Input, Commands, and Functions if you have
troubles or ask colleagues for help.

Carefully check algebraic input before hitting the Enter key. If an error
message appears, read it! It might help you to fix the problem.

Make sure, you know how to use corresponding geometry tools before
you begin the construction. If you don’t know how to operate a certain tool,
activate it and read the toolbar help.

If you have questions, please ask a colleague before you address the
presenter or assistant(s).
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Activity Il.a: Parameters of a Linear Equation

Classification: Basic task

In this activity you are going to use the following tools, algebraic input, and
commands. Make sure you know how to use them before you begin with the
actual construction.

_2%%  Slider X Intersect Two Objects
line: y = m x + b / Slope New!

~  Segment Between Two Points “~  Show / Hide Object
Intersect[line, yAxis] % Move

Hint: You might want to have a look at the file A_2a_parameters line.html first.

Construction Steps

1. Enter: line: y = 0.8 x + 3.2 mg05 N
b=1
Task 1: Move the line in the algebra ° ?
view using the arrow keys. Which —1os
parameter are you able to change in /;
thIS Way? 4 3 2 1 0 1 2 3 4

Task 2: Move line in the graphics view line ™
with the mouse. Which transformation
can you apply to the line in this way?

2. Delete the line. Create sliders m and b using the default settings of sliders.

3. Enterline: y = m x + b.

Hint: Don’t forget to use an asterisk or space to indicate multiplication!

4. Task 3: Write down directions for your students that guide them through
examining the influence of the equation’s parameters on the line by using
the sliders. These directions could be provided on paper along with the
GeoGebra file.

Challenge: Enhance this construction by showing the slope and y-intercept.
5. Create the intersection point between the line and the y-axis.
Hint: Use tool ~< Intersect or command Intersect[line, yAxis].
6. Create a point at the origin and draw a segment between these two points.
7. Use tool - Slope and create the slope (triangle) of the line.
8. Hide unnecessary objects and modify the appearance of the other ones.

35



Introduction to GeoGebra @

Activity Il.b: Introducing Derivatives — The Slope Function

Classification: Advanced task

In this activity you are going to use the following tools, algebraic input, and
commands. Make sure you know how to use them before you begin with the
actual construction.

O

|,

f(x) = x*2/2 + 1 S = (x(A), slope)

New Point < Segment Between Two Points
Tangent Q Move

slope = Slope[t]

Hint: You might want to have a look at the file A_2b_slope function.html first.

Construction Steps

1.

2.

. Create tangent t to function f through

Enter the polynomial: f (x) = x"2/2
+ 1

Create new point A on function f.

Hint: Move point A to check if it is really
restricted to the function graph.

point A.
Create the slope of tangent t using:
slope = Slopelt]

Define point S: s = (x(A), slope)

Hint: x (2) gives you the x-coordinate of point A.

Connect points A and S using a segment.

Task: Move point A along the function graph and make a conjecture about
the shape of its path, which corresponds to the slope function.

Challenge: Find the equation of the slope function.

8.

Turn on the trace of point S. Move point A to check your conjecture.
Hint: Right click point S (MacOS: Ctrl-click) and select # Trace on.

9. Find the equation of the resulting slope function. Enter the function and

move point A. If it is correct the trace of point S will match the graph.

10.Change the equation of the initial polynomial f to produce a new problem.
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Activity ll.c: Creating a ‘Function Domino’ Game

Classification: Basic task

In this activity you are going to practice exporting function graphs to the clipboard
and inserting them into a word processing document in order to create cards for
a ‘Function Domino’ game. Make sure you know how to enter different types of
functions before you begin with this activity.

Construction Steps

1.
2.

3.

Enter an arbitrary function. Example: e (x) = exp (x)

Move the function graph into the upper left corner of the graphics view and
adjust the size of the GeoGebra window.

Export the graphics view to the clipboard (menu File — Export — Graphics
View to Clipboard).

Open a new word processing document.

Create a table (menu Insert — Table...) with two columns and several
rOWS.

Place the cursor in one of the table cells. Insert the function graph from
the clipboard (menu Home — Paste or key combination Ctrl — V).

Adjust the size of the picture if necessary (double click the picture to open
the Format tab and click on Size).

Enter the equation of a different function into the cell next to the picture.
Hint: You might want to use an equation editor.

Repeat steps 1 through 8 with a different function (e.g. trigonometric,
logarithmic).

Hint: Make sure to put the equation and graph of each function on different
domino cards.

e(x)=¢e"

>

x-=(0)f
\/; DA

< a(x)= ‘x‘ e

r(x)
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Activity Il.d: Creating a ‘Geometric Figures Memory’ Game

Classification: Advanced task

In this activity you are going to practice exporting function graphs to the clipboard
and inserting them into a word processing document in order to create cards for
a memory game with geometric figures. Make sure you know how to construct
different geometric figures (e.g. quadrilaterals, triangles) before you begin with
this activity.

Construction Steps

1.
2.
3.

No o

8.

9.

Create a geometric figure in GeoGebra (e.g. isosceles triangle).

Use the Properties dialog to enhance your construction.

Move the figure into the upper left corner of the graphics view and adjust
the size of the GeoGebra window.

Export the graphics view to the clipboard (menu File — Export — Graphics
View to Clipboard).

Open a new word processing document.

Create a table (Insert — Table...) with three columns and several rows.

Set the height of the rows and the width of the columns to 5 cm (2 inches).
Hint: Place the cursor in the table and open the Table Properties dialog
with a right click. On tab Row specify the row height. On tab Column enter
the preferred width. On tab Cell set the vertical alignment to Center. Click
OK when you are done.

Place the cursor in one of the table cells. Insert the picture from the
clipboard (menu File — Paste or key combination Ctrl — V).

Adjust the size of the picture if necessary (double click the picture to open
the Format Picture tab, click on Size and specify the size).

10. Enter the name of the geometric shape into another cell of the table.
11.Repeat steps 1 through 10 with different geometric figures (e.g. circle,

quadrilaterals, triangles).

EQUILATERAL
TRIANGLE SQUARE o
PARALLELOGRAM CIRCLE
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7. Inserting Pictures into the Graphics View

Activity 13: Drawing Tool for Symmetric Figures

Back to School...

Open the dynamic worksheet A13 drawing tool symmetry.html. Follow the
directions on the worksheet and experience how your students could explore the

axes of symmetry of a flower.

Hint: You will learn how to create such dynamic worksheets later in this

workshop.
Axes of Symmetry
Below you can see a point A who was reflected at the line in order to create its image A".
File Edit View Options Tools Help
> g
1. Drag point A with the mouse along the
outline of the flower. What do you notice?
Write down your observations.
2. How many axes of symmetry does
this flower have?
Hint: Drag the green points in order to
change the position of the line of
reflection. Then, repeat step (1) for every
position of the line
Hint: Press the keys Ctrl + F at the same
time in order to delete the traces
3. Make a sketch of this worksheet
including the flower and all lines of
symmetry you were able to find
Discussion
e How could your students benefit from this prepared construction?
¢ Which tools were used in order to create the dynamic figure?
Preparations
e Open a new GeoGebra window.
¢ Hide algebra view, input bar and coordinate axes (View menu).

Construction Steps

1 .‘“‘ New point A

2 | A A | Show the label of point A

3 / Line of reflection through two points

4 N Mirror point at line to get image A’

5| " | Segmentbetween point A and its image A’
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6 -’ Turn the Trace on for points A and A’

Hint: Right click (MacOS: Ctrl — click) the point and select Trace on
from the menu. Whenever point A is moved it leaves a trace in the
graphics view.

7 Q Move point A to draw a dynamic figure

Discussion

The #* Trace on feature has some special characteristics:
e The trace is a temporary phenomenon. Whenever the graphics are
refreshed, the trace disappears.
The trace can’t be saved and is not shown in the algebra view.
To delete the trace you need to refresh the views (menu View — Refresh
Views or key combination Ctrl — F. MacOS: Open Apple-F).

Enhancing the Construction
Note: Make sure you have the picture A73_flower.jpg saved on your computer.

8 '?5 Insert image into the graphics view

Hint: Click in the lower left corner of the graphics view to insert the
picture at this position.

9 [+ | Adjust the position of the inserted image.

10 Set the image as background image (Properties dialog, tab Basic).

11 Reduce the filling of the image (Properties dialog, tab Style).

Hint: After specifying the picture as a background image you need
to open the Properties dialog using the Edit menu. You can'’t select

a background image in the graphics view any more.
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Activity 14a: Resizing and Reflecting a Picture

In this activity you will learn how to resize an inserted picture to a certain size and
how to apply transformations to the picture in GeoGebra.

Preparations

Make sure you have the picture A14 Sunset Palmtrees.jpg saved on your
computer.

Open a new GeoGebra window.

Close the algebra view and hide the coordinate axes.

Construction Steps

1 Insert picture A14 Sunset Palmitrees.jpg on the left part of the
graphics view

2 ."" New point A at the lower left corner of the picture

3 Set point A as the first corner point of your picture.
Hint: Open the Properties dialog and select the picture in the list of
objects. Click on tab ‘Position’ and select point A from the drop-
down list next to Corner 1.

4 B=2A+ (3, 0)

5 Set point B as the second corner point of the picture.
Hint: You just changed the width of the picture to 3 cm.

6 / Vertical line through two points in the middle of the graphics view

7 N Mirror the picture at the line
Hint: You might want to reduce the filling of the image in order to be
able to better distinguish it from the original.

Tasks

(a) Move point A with the mouse. How
does this affect the picture?

(b) Move the picture with the mouse and
observe how this affects its image.

(c) Move the line of reflection by dragging
the two points with the mouse. How does
this affect the image?
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Activity 14b: Distorting a Picture

In this activity you will learn how to resize an inserted picture to an arbitrary size
and how to distort a picture in GeoGebra.

You will now modify the construction created in activity 14a. If you want to keep
the original as well, you need to save your file.

Construction Steps

1 Start with the figure you created in activity 14a.

2 7 Delete the point B to restore the picture’s original size

3 .‘“‘ Create a new point B at the lower right corner of the original picture
4 Set the new point B as the second corner point of your picture.

Hint: You can now resize the image by moving point B.

5 .‘“‘ Create a new point E at the upper left corner of the original picture

6 Set the new point E as the fourth corner point of your picture

Tasks

(a) How does moving point E affect the picture and its image?
(b) Which geometric shape do the picture and the image form at any time?
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Activity 14c: Exploring Properties of Reflection

In this activity you will create a dynamic figure that allows your students to
explore the properties of reflection.

You will now modify the construction created in activity 14b. If you want to keep
the original as well you need to save your file.

Construction Steps

1 Start with the figure you created in activity 14b.

2 ,/' Segment between points A and B

3| " |Segmentbetween points A and E

4 r:f Parallel line to segment AB through point E

5 r:f Parallel line to segment AE through point B

6 >( Intersect the two lines to get intersection point F

7 | ¥~ |Hide auxiliary objects

8 N Reflect all four corner points at the line to get their images

9 /' Connect corresponding points with segments (e.g. points A and A’)
10 ,{' Create angles between the line of reflection and the segments
Task

Move the corner points of the original picture, as well as the line of reflection.
What do you notice about the angles between the segments and the line of
reflection? What can we call the line of reflection in relation to the segments
formed by each point and its corresponding image?

L ]
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8. Inserting Text into the Graphics View
Activity 15: Coordinates of Reflected Points

Preparations

e Open a new GeoGebra window.

e Show the algebra view, input bar, coordinate axes and the grid (View
menu).

¢ In the Options menu set the Point capturing to Fixed to Grid.

1 o' | Create pointa = (3, 1)

2 Createlinea: y = 0

3 N Mirror point A at line a to get point A’

4 Change the color of line a and point A”.
5 Createlineb: x = 0

6 N Mirror point A at line b to get point A;’

7 Change the color of line b and point A;’.

Inserting static text

Insert a heading into the graphics view of GeoGebra so your students know what
this dynamic figure is about:
¢ Activate the “* Text tool and click on the upper part of the graphics view.
¢ Type the following text into the appearing window:
Reflecting a point at the coordinate axes
e Click OK.
e Adjust the position of the text using the Move tool.

Hints: You can change the properties of the text in the Properties dialog (e.g.
wording, font style, font size, formatting). On tab Basic you can fix the position of
the text so it can’t be moved accidentally any more.

Inserting dynamic text

Dynamic text refers to existing objects and adapts automatically to modifications,
for example A = (3, 1).
e Activate the “*= Text tool and click on the graphics view.
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Note:

Type A = into the appearing window:

Hint: This will be the static part of the text and won’t change if point A is
moved.

Insert the dynamic part of this text by selecting point A from the Objects
drop-down list.

Click OK.

The text shows the coordinates of point A and adapts automatically to

modifications of its position.

Enhancing the dynamic figure

Task

Insert dynamic text that shows the coordinates of the reflected points A’
and A,
Zoom out in order to show a larger part of the coordinate plane.
Hint: You might want to adjust the distance of the grid lines.
o Open the Properties dialog for the Graphics View (right click /
MacQOS: Ctrl-click the graphics view and select Graphics)
o Select tab Grid
o Check the box next to Distance and change the values in both text
fields to 1
Close the algebra view and fix all text so it can’t be moved accidentally.

Reflecting a poirltt at the coordinate axes

A=(3,1)
A'=(3,-1)
2
A= (-3,1)
1 ' A
0A1 Q
0
6 4 2 0 2 4 6

Come up with instructions to guide your students towards discovering the relation
between the coordinates of the original and the reflected points which could be
provided along with the dynamic figure.
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Activity 16: Rotation of a Polygon

Preparations

Open a new GeoGebra window.
Hide algebra view and input bar if necessary.
Show the coordinate axes and the grid.
Open the Properties dialog for the graphics view:
o On tab xAxis change the Distance to 1
o On tab yAxis change the Distance to 1

Construction Steps

1 :“: Create an arbitrary triangle ABC

2 .F‘ New point D at the origin of the coordinate system

3 Rename the new point to O
Hint: GeoGebra offers a ‘fast-renaming’ option. Activate Move
mode and select the object. When you start typing the new name
GeoGebra opens the Rename dialog window.

4 232 | Create a slider for angle a
Hint: In the slider dialog window check Angle and set the increment
to 90°.

5 : « | Rotate triangle ABC around point O by angle a
Hint: Check counter clockwise rotation.

6 | .~ |Segments AOand A0

7 | & | Angle AOA
Hint: Select the points in counter clockwise order. Hide the label of
this angle.

8 [+ | Move slider and check the image of the triangle

Enhancing the Construction

1

ABC | Insert static text: Rotation of a Polygon

2

ABC | Insert dynamic text: A = and select Point A from Objects

ABC | Insert dynamic text: A’ = and select Point A” from Objects
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4 Q Move slider and text to desired positions
5 Fix the position of the slider (Properties dialog — tab Slider)
6 Fix the position of the text (Properties dialog — tab Basic)

Rotating a Polygon

az270°
—_— et
o] 4]
A=(-3,1) a 3| A
A'=(1, 3) b !
B 2 /I C
c 1|/
ATl . B

Discussion

How could you use this file to introduce the concept of rotating an object around
the origin of a coordinate system to your students?
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9. Practice Block Il

This practice block consists of a pool of activities to practice inserting pictures
and text into the graphics view of GeoGebra. Activities of two different difficulty
levels are available: Basic tasks and Advanced tasks. You can pick tasks of your
interest and work on them either on your own or together with a colleague.

Tips and Tricks

For each of these activities, open a new GeoGebra file. Check prior to
beginning the activity if you need to show or hide the algebra view, input
bar and coordinate axes.

If you choose to work on an activity that involves inserting a picture into
GeoGebra, make sure you have these picture files saved on your
computer before you begin with the activity.

You might want to save your files before you start a new activity.

Don’'t forget about the Undo and Redo buttons in case you make a
mistake.

Frequently use the Move tool in order to check your construction (e.g. are
objects really connected, did you create any unnecessary objects).

Make sure you know the syntax to enter algebraic expressions and
functions. Read through the Tips and Tricks section in the beginning of
topic Basic Algebraic Input, Commands, and Functions if you have
troubles or ask colleagues for help.

Carefully check algebraic input before hitting the Enter key. If an error
message appears, read it! It might help you to fix the problem.

Make sure, you know how to use corresponding geometry tools before
you begin the construction. If you don’t know how to operate a certain tool,
activate it and read the toolbar help.

If you have questions, please ask a colleague before you address the
presenter or assistant(s).
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Activity lll.a: Visualizing a System of Equations

Classification: Basic task

In this activity you are going to use algebraic input and commands. Make sure
you know the syntax for algebraic input and commands before you begin.

You might want look at the dynamic  worksheet called
A 3a_system equations.html in order to find out how your students could use
this construction to graphically solve a system of linear equations.

Construction Steps

Create sliders m_1 and b_1 using the default settings for sliders.
Create the linearequation1 1: vy = m 1 x + b 1.
Create sliders m_2 and b_2 using the default settings for sliders.
Create the linear equation1 2: v = m 2 x + b 2.
Create dynamic text1: Line 1: and select/_ 7 from Objects.
Create dynamic fext2: Line 2: and select/ 2 from Objects.
Construct the intersection point A of both lines either using tool -<
Intersect two objects or command A = Intersect[1l 1, 1 2].
8. Define xcoordinate = x (A).
Hint: x(A) gives you the x-coordinate of point A.
9. Define ycoordinate = y(A).
Hint: y(A) gives you the y-coordinate of point A.
10.Create dynamic text3: Solution: x = and select xcoordinate from
Objects. Type in y = and select ycoordinate from Objects.

Noohkhwb=

o
N
n
N
o

PR To ™
Line2:y=-x+2

Solution: x=1

y=1

] ' ' '
a A W N
L L L L

Challenge: Create a similar construction that allows for visualizing the graphical
solution of a system of quadratic polynomials.
Hint: Functions need to be entered using the syntax £ (x) = ..

Note: Such a dynamic figure can also be used to visualize an equation in one
variable by entering each side of the equation as one of the two functions.
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Activity lll.b: Translating Pictures

Classification: Basic task

In this

activity you are going to use the following tools and commands. Make sure
you know how to use each tool and command before you begin.

Insert Image o~ Vector Between Two Points  New!

A= (1, 1) }, Translate Object By Vector New!

Polygon [ Move

Vector [0, P] ABC Text

Construction Steps

1.

hown

oo

8.
9.
10.
11.

Challenge

Open a new GeoGebra window. Show the algebra view, input bar,
coordinate axes, and grid. In the Options menu set the point capturing to
Fixed to Grid.

Insert picture A_3b_Bart.png into the first quadrant.

Create pointsa = (1, 1),B = (3, 1),andD = (1, 4).

Set point A as the first, B as the second, and D as the fourth corner point of
the picture (Properties dialog, tab Position).

Create triangle ABD.

Create pointo = (0, 0) andpointP = (3, -2).

Create vector u = Vector [0, PJ.

Hint: You could also use tool «* Vector Between Two Points.

Translate the picture by vector u using tool “~ Translate Object By Vector.
Hint: You might want to reduce the filling of the image.

Translate the three corner points A, B, and D by vector u.

Create triangle A'B’D".

Hide point O so it can’t be moved
accidentally. Change the color
and size of objects to enhance 3
your construction. 2

Insert dynamic text that shows 0 " I S

the coordinates of points A, B, C, P
A’ B’ and D’. o &
the coordinates of vector u.
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Activity lll.c: Constructing a Slope Triangle

Classification: Advanced task

In this activity you are going to use the following tools and algebraic input. Make
sure you know how to use each tool and the syntax for algebraic input before you

begin.

Line Through Two Points run = x(B) - x(A)
Perpendicular Line slope = rise / run
Intersect Two Objects ABC  Text

Polygon _" Midpoint or Center
rise = y(B) - y(A) v Move

Construction Steps

1.

abhwbn

N o

Calculate the run: -

run = x(B) - x(A) 4

Hint: x (B) gives you the slope = 075

x-coordinate of point B.

Enter the following equation y

into the input bar to calculate b%

the slope of line a: R R R

slope = rise / run N '5/ 2o
10. Insert dynamic text: 2 |

Show the algebra view, coordinate axes and the grid. Set point capturing
to Fixed to Grid and the labeling to All new objects.

Create line a through two points A and B.

Construct a perpendicular line b to the y-axis through point A.

Construct a perpendicular line ¢ to the x-axis through point B.

Intersect perpendicular lines b and c to get intersection point C.

Hint: You might want to hide the perpendicular lines.

Create polygon ACB and hide the labels of the sides.

Calculate the rise: rise = y(B) - y(A)

Hint: v (2) gives you the y-coordinate of point A.

rise = and select rise
from Objects

run = and select run from
Objects

slope = and select slope
from Objects

11.Change properties of objects in order to enhance your construction.
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Challenge 1: Insert a dynamic text that contains a fraction

Using LaTeX formulas, text can be enhanced to display fractions, square roots,
or other mathematical symbols.

1.

Activate tool *** Insert text and click on the graphics view.

2. Type slope = into the Insert text window’s input bar.

3.

Check LaTeX formula and select Roots and Fractions a/b from the drop-
down list.

Place the cursor within the first set of curly braces and replace a by
number rise from the Objects drop-down list.

Place the cursor within the second set of curly braces and replace b by
number run from the Objects drop-down list.

Click OK.

Challenge 2: Attach text to an object

Whenever an object changes its position, attached text adapts to the movement
and follows along.

1. Create midpoint D of the vertical segment using tool - Midpoint or center.
2.
3. Open the Properties dialog and select text1 (rise = ...). Click on tab

Create midpoint E of the horizontal segment.

Position and select point D from the drop-down list next to Starting point.

. Select text2 (run = ...) in the Properties dialog and set point E as starting

point.
Hide the midpoints D and E.

slope = 0.5

rise =3
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Activity lll.d: Exploring the Louvre Pyramid

Classification: Advanced task

In this activity you are going to use the following tools and some algebraic input.
Make sure you know how to use every single tool and the syntax for algebraic
input before you begin. Also, check if you have the picture A 3d Louvre.jpg
saved on your computer.

£y

~ 4 [Insert Picture #;:E__J Perpendicular Line
/'/ Line Through Two Points X Intersect Two Objects
" slope ’_ Show / Hide Object
4 Angle ~  Segment

o’ New Point [ Move

The Louvre in Paris is one of the most visited and famous art museums in the
world. The building holds some of the world's most famous works of art, such as
Leonardo da Vinci's Mona Lisa. In 1989 the main entrance of the museum was
renovated and a glass pyramid was built (from
http://en.wikipedia.org/wiki/Louvre, February 20, 2008).

Determine the slope of the pyramid’s faces 1

1. Set point capturing off. Set the decimal 31
places to 1. Change the labeling setting to
All new objects (menu Options).

2. Insert the picture A _3d Louvre.jpg into |
the first quadrant of the coordinate s,
system. The left lower corner should y ']
match the origin.

3. Reduce the filling of the picture (about 50%) and set it as background
image (Properties dialog).

4. Create a line through two points with the first point at the base and the
second point at the vertex of the pyramid.

Hint: Change the properties of line to improve its visibility.

5. Use the /" Slope tool to get slope triangle of line.
Hint: Change the properties of slope triangle to improve its visibility.
Hint: The slope triangle is attached to the point created first.

6. Task: Determine the slope of the pyramid’s faces in percent.

7. Create the angle between the x-axis and the line.
Task: Determine the inclination angle for the pyramid’s face.

5 6
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Challenge

The pyramid’s base is a square with a side length of 35 meters. Determine the
height of the pyramid using similar triangles.

1. Create a new point C on the line.

2. Construct the slope triangle of the line using points C and B at the
pyramid’s vertex.
Hint: Create a line perpendicular to the y-axis through point C and a line
perpendicular to the x-axis through point B at vertex of pyramid.
Create the intersection point D of the two lines.
Hint: Hide the auxiliary lines.

3. Use segments to connect point D with points B and C.
Hint: Change the properties of the segments to increase their visibility.
Hint: You might want to rename the vertical segment to height and the
horizontal segment to halfBase.3

4. Move point C along the line until the horizontal segment of the triangle
matches the level of the road in front of the pyramid.

5. Task: Calculate the height of the pyramid using similar triangles.
Hint: Use the slope triangle and your new triangle. Remember that the
base side length is 35 m.

Check your answer with GeoGebra ]

6. Show name and values of segments 5
height and halfBase.

7. Drag point C until the horizontal
segment has length 35/2 = 17.5.
Hint: You might need to zoom out of
the construction and / or move the
graphics view in order to be able to -
do this.

8. Check if the height of the pyramid
matches your answer.

15 20
height = 21

., | halfBase =17.5 |

Comment

By implementing the instructions above you were able to graphically determine
the approximate value for the pyramid’s height. In reality, the Louvre pyramid has
a base length of 35 m and a height of 21.65 m. Its faces have a slope of 118%
and an inclination angle of about 52° (from
http://de.wikipedia.org/wiki/Glaspyramide im_Innenhof des Louvre#Daten,
February 22, 2008).
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10. Combining Spreadsheet View & Graphics View

GeoGebra provides different views of mathematical objects: a graphics view, a
numeric algebra view and a spreadsheet view. Thereby, all representations of
the same object are linked dynamically and adapt automatically to changes made
to any of the representations, no matter how they were initially created.

D et (x4 1.04) 4 (y — 2.78)°

=2 |||[ & || ZoomOut \J
) Click o pt zoom out (! e Wheel)
@0 [spreadshest EE®
1 1 2
:
Graphics = @
9 F=(4.94,386) - 2 ‘
5 6=(4.86,524) £l s 7
Dependent Objects I w 6 6
7 7 2
8

3 d:(x— 7.46)% + (y +1.28)
@ e=6.99
@ f=25

@ g=683
2 polyl=8.48

PN readsheet

Algebra —— T T T Ve View
View : :
7 Graphics 2 = B 5% 18

i Graphics -
| ~View 2 .

ER—

Spreadsheet Cells Input

In GeoGebra’s spreadsheet view every cell has a specific name that allows you
to directly address each cell. For example, the cell in column A and row 1 is
named A17.

Note: These cell names can be used in expressions and commands in order to
address the content of the corresponding cell.

You can not only use numbers in spreadsheet cells, but all types of mathematical
objects that are supported by GeoGebra (e.g., coordinates of points, functions,
lines). If possible, GeoGebra immediately displays the graphical representation of
the object you enter into a spreadsheet cell in the graphics view as well. Thereby,
the name of the object matches the name of the spreadsheet cell used to initially
create it (e.g., A5, C1).

Note: By default, spreadsheet objects are classified as auxiliary objects in the

algebra view. You can show or hide these auxiliary objects by selecting ‘Auxiliary
Objects’ from the styling bar at the top of the algebra view.
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Activity 17a: Record to Spreadsheet

Preparations

e Open a new GeoGebra window.
e (o to Perspectives — Spreadsheet & Graphics.

Construction Steps

Create a slider a with default interval and increment 1.

Hint: Select tool Slider and click in the graphics view to set
the position for the slider.

In the appearing dialog window change the increment to 1
and click the Apply button.

Create point A by entering2 = (a, 2a) into the Input Bar.

2 | A= (a, 2a) | Hint: The value of slider a determines the x-coordinate of
point A while the y-coordinate is a multiple of this value.

3 A Show the label of point A in the graphics view.

4 % Change the value of slider a to examine different positions of
point A.
Use tools Move Graphics View, as well as Zoom In and

5 e Zoom Out to adjust the visible part of the graphics view and
make point A visible in all positions.

R &

56

Record the coordinates for different positions of point A to
the spreadsheet:

(1) Select tool Record to Spreadsheet. Then, click on
point A in order to highlight it.

Note: The coordinates for the actual position of point
A are immediately entered into cells A7 (x-coordinate)
and B1 (y-coordinate) of the spreadsheet.

Now, change the value of slider a in order to record
the coordinates of all other possible positions of point
A to the spreadsheet as well.

Note: Do not switch to another tool before moving the
slider.

56




Introduction to GeoGebra

£ GeoGebra = | & =

File Edit View Perspectives Options Tools Window Help
A Pl s . i ED
tote

Graphics & FEE)[x] [spreadsheet EE=
A [ s [ e
acs N 1] 5 A0 B
-— 2 4 3
EN 3 5
b ° [ 4| 2 4 =
| 5 | 1 2
N ® 6 | 0 0
(7| 1 2
° hd N 2 1
9 | 3 6
4 ® T10 | 4 8
11| 5 10
24 e =

-
X}

-
1

&
&
IS
fa
o
o
=
S
o
o
=

-
o

-
=

L ]
IS
n
JEe
@ |~

=
©

L]

&
(]
=

| 21 |
. =] 22
. B
[] 10 24
< v
Input s

Activity 17b: Relative Copy and Linear Equations

Preparations

e Open a new GeoGebra window.
o Go to Perspectives — Spreadsheet & Graphics.

Construction

Steps

Activate tool Move Graphics View and drag the origin of the
coordinate system close to the lower left corner of the
graphics view.

In the spreadsheet view, click on cell A1 enter the point

2 (0, 0) .
coordinates (0, 0).
3 a1 In the spreadsheet view, click on cell A2 enter the point
! coordinates (1, 1).
4 AN Show the labels of both points in the graphics view.
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o

(1)
(2)

3)

Highlight both cells A7 and A2 by using the mouse.
Click on the little square at the lower right corner of
the highlighted cell range.

Hold the mouse button down and drag the pointer
down to cell A71.

Relative copy the inserted point coordinates to other cells in
column A:

Use tools Move Graphics View, as well as Zoom In and

6 Zoom Out to adjust the visible part of the graphics view and
O make all points visible.
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Task 1: Examine the coordinates of the point sequence

What sequence of numbers is created if you apply the ‘relative copy’ feature of
the GeoGebra spreadsheet the way it is described above?
Hint: Examine the x-coordinates of all created points and come up with a
conjecture about how they are related. Then, check your conjecture using the y-

coordinates of the points.

Task 2: Find the matching equation

Make a prediction about an equation that would create a graph going through all
points of this sequence. Enter this equation into the Input bar in order to check

your prediction.
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Activity 17c: Best Fit Line

Preparations

e Open a new GeoGebra window.
e (o to Perspectives — Spreadsheet & Graphics.
¢ In the Options menu set the Labeling to New Points Only.

Construction Steps
Enter the following numbers into the spreadsheet cells of column
1 A:
A1 1 A2. 5 A3 2 A4. 8 A5 -2
Enter the following numbers into the spreadsheet cells of column
2 B:
B1. -1 B2: 2 B3: 3 B4. 4 B5: 1
Use tool Two Variable regression Analysis in order to create the
3 E_,'/" function that best fits your data points.
Highlight the cells and then click the tool.
4 Try to find the function that best fits your points by selecting
different Regression Models.

7 Regression Analysis P
Scatterplot -
¥: Column B
44 ° _—

,---""F—_‘-‘
® rd_/—""_-_
_—_——""/_F—___
=24 o ” [=]
° _——
_——/—__
o _—
[}
2 0 2 3 6 g
X Column A
Regression Model
Linear - y = 0.34x + 0.86
KEY Evaluate: x= y=
Options ¥ ‘ I Close ‘
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Task 1: Examine the regression models

Why do some models not work with the points you entered? Enter different points
and try the Two Variable Regression Analysis Tool again.

Task 2: Polynomial Regression

Select the Polynomial Regression Model and observe what happens to the
function when you change the order of the polynomial function.

Importing Data from other Spreadsheets

Note: GeoGebra allows you to copy and paste data from other spreadsheet
software into the GeoGebra spreadsheet:

e Select and copy the data you want to import (e.g. use the keyboard
shortcut Ctrl-C in order to copy the data to your computer’s clipboard).
Note: You need to press both keys (e.g., Ctrl-key and C-key) at the same
time in order to apply a keyboard shortcut.

e Open a GeoGebra window and show the spreadsheet view.

¢ Click on the spreadsheet cell that should contain the first data value.

e Paste the data from your computer's clipboard into GeoGebra’s
spreadsheet view. In order to do so, you can either use the keyboard
shortcut Cirl-V or right click (MacOS: Ctri-click) on the highlighted cell and
select 'l Paste from the appearing context menu.

Activity 17d: Exploring Basic Statistics

Yesterday, you gave a mathematics quiz to the 25 students of your 1 period
math class. After the quiz, you asked your students to rate the difficulty of the
quiz on a scale from 1 (‘very easy’) to 5 (‘very difficult’).
e 4 of your students rated the quiz ‘very easy’ (1)
6 students rated the quiz ‘easy’ (2)
6 other students rated the quiz ‘difficult’ (4)
1 student rated the quiz ‘very difficult’ (5)
The rest of the students thought the difficulty of the quiz was ‘ok’ (3).

Task 1: Create a histogram

Enter the data into GeoGebra's spreadsheet and create a histogram that
visualizes this data.
Hints:
e Use the One Variable Analysis Tool in order to create a histogram.
¢ Note: Change the slider Classes in the appearing window to control the
number of bars that are shown in your histogram.
e Enhance the histogram by setting the classes manually and changing the
start and width parameter.
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Task 2: Determine mean and median

1. Make a prediction for mean and median of the data you collected.
2. Compare your solution by checking the left table of the One Variable
Statistics window.

-
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11. Creating Static Instructional Materials

Activity 18a: Saving Pictures as Files

In this activity you will learn how to export a picture from GeoGebra into a file.
Compared to exporting it to the clipboard (see activity 12a) this export possibility
has several advantages:
¢ You can save your picture and reuse it later on. This isn’t possible with the
clipboard since data is just stored temporarily there and can’t be reused in
a later session.
¢ You can determine the scale of your picture which comes in handy if you
want your students to use the sketch for measurements.
¢ You can change the resolution of your picture and thus, change the size of
the picture file. The resolution determines the quality of the picture: For a
good quality printout we recommend a rather high resolution (about 300
dpi). In order to upload the picture to a website you want to have a smaller
file and to use the usual resolution of 72 dpi.
Hint: dpi means “dots per inch”.
e You can determine the format of your picture. GeoGebra offers several
different picture formats. The default setting is Portable Network Graphics
(png) which is fine for inserting the picture into word processing and
presentation software.
Hint: If you don’t know the other formats don’t worry about them.

Create your figure

Create a simple construction in GeoGebra. For example use the ‘- Regular
polygon tool in order to create a square, pentagon, or hexagon in the graphics
view.
e Activate the tool and click on the graphics view
twice in order to determine the side length of the
regular polygon.
e Type the number of vertices (e.g. 6 for a
hexagon) into the appearing dialog window and
click OK.

Again, GeoGebra will export the whole graphics view into the picture file. Thus,
you need to make the GeoGebra window smaller in order to reduce unnecessary
space in the graphics view:

e Move your figure (or the relevant section) to the upper left corner of the
graphics view using the * Move Graphics View tool (see left figure
below).

Hint: You might want to use tools ®& Zoom in and \ Zoom out in order to
prepare your figure for the export process.
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¢ Reduce the size of the GeoGebra window by dragging its lower right
corner with the mouse.
Hint: The pointer will change its shape when hovering above an edges or
corner of the GeoGebra window.

Exporting a picture as a file

Use the File menu to export the graphics view as a picture:

e Export — Graphics View as Picture
Hint: You could also use the key combination Ctrl — Shift — P.

e If you want to you can change the settings in the appearing window
(picture format, scale, resolution).
Hint: Always check the size of your picture (in cm or dpi). If your picture
doesn’t fit on a piece of paper you might need to modify your figure prior to
the export. This is especially important if you want to keep the scale of the
picture for the word processing or presentation document.

e Click Save and save your picture in your GeoGebra_Introduction folder.
Your figure is now ready to be inserted into any word processing or
presentation document.

Edit View Perspectives Options Tools Window Help
L Mew Window

New
& Open ...
E Open Webpage ..
Open Recent L4
@ Save
Save As ..
2} Share. ..
Export | F Dynamic Worksheet as Webpage (html) ...
w EE— Graphics View as Picture (png, eps) ...
Graphics View as Animated GIF _.
[ Close ] Graphics View to Clipboard

Graphics View as PSTricks ...
Graphics View as PGRITIEZ ...

Graphics View as Asymptote .

Activity 18b: Inserting Pictures into a Text Processing Document

After exporting a figure from GeoGebra into a picture file you can now insert it
into a word processing document.

Inserting a picture file into MS Word

e Open a new text processing document
e From the Insert tab, in the lllustrations group select Picture.
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e Select your picture in the appearing dialog window.
Hint: You might have to navigate through the folders in order to find it.
o Clicking the Picture button inserts the picture at the position of the cursor.

Home Insert Pa
5 )= E

e Layout References Mailings Review View

Ry 2l - ® = [EH

Cover Blank Page Table Clip  Shapes Smartart Chart Hyperlink Bookmark Cross-reference
Page~= Page Break = Art w2
Pages Tables Illustrations Links

Reducing the size of pictures

If necessary you can reduce the size of the picture in MS Word:
e Double click the inserted picture.
e Change the height/width of the picture using the Size group on the right.

|
Home Insert Page Layout References Mailings Review View | Format |
i Brightness ~ :i Compress Fictures |_ DT L / =] "j .Q.Aligl’v h _‘_\[:j ;J Height: 0,61 cm
(b Contrast = " Reset Picture D90, — — %)
Shadow Paosition Wrap Crop | == :
g Recolor ~ Effects = = - Text~ Zk Rotate ~ co: Width: |0,61 cm

Adjust Shadow Effects Border Arrange Size

Note: If you change the size of a picture, the scale is modified. If you want to
maintain the scale (e.g. for your students to measure lengths) make sure the size
of the picture is 100%.

Note: If a picture is too big to fit on one page MS Word will reduce its size
automatically and thus, change its scale.

Inserting a picture file into OO Writer e et view [ romat Table Tools Window belp

Manual Break...

e Open a new text processing Fields -
dOCU ment g Special Character...
Formatting Mark 3

e From the Insert menu select

Picture — From File. section.
. . @ Hyperlink
e Select your picture in the s
. . . eader 3
appearing dialog window. i X
Hint: You might have to navigate Footnote/Endnote,.
through the folders in order to find e
It 5 Bookmark..
. . . %. Cross-reference...
e Clicking the Insert button inserts ;__J Comment
the picture at the position of the Seript..
cursor. Indexes and Tables v
Envelope...
[£] Frame..
FH Table.

Horizontal Ruler...

#_IT Maovie and Sound Scan .

Object s
[C] Floating Frame
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12. Creating Dynamic Worksheets

Introduction: GeoGebraTube and User Forum

Dynamic Worksheets

GeoGebra allows you to create your own interactive instructional materials, so
called dynamic worksheets, by exporting dynamic figures into web pages.
Usually, a dynamic worksheet consists of a heading, short explanation,
interactive applet, as well as tasks and directions for your students.

In order to work with dynamic worksheets your students don’t need to know how
to operate GeoGebra at all. The interactive web pages are independent of the
software and can be provided either online or on a local storage device.

GeoGebraTube

GeoGebraTube (http://www.geogebratube.org/) is a pool of free instructional
materials that were created by people from all over the world. They are grouped
in different tags in order to organize their content and make them easier to
access.

@ GeoGebraTube - Morilla Firefox = B

| © GeoGebraTube L+ -
S—/ 0 hitp://uww.geogebratube.org/ Ik
GeaGebra

About Download Help Materials  Community

Overview Search  Upload material ‘

YOU ARE HERE: GeoGebraTube - Overview Welcome visitor!
o

Login

(e

Featured materials ‘

Q "W ----- _

Discovering Pythagoras'
Theorem by Area

-Repnrli Bug!

Folding and lines of
symmetry in the square

Wstgga Mobiusa

=
Surface Area for Cuboid

1o

Popular Tags

70

1o

a0

Material Types

Worksheet Tool
Publication Tutos

geometry circie article graniastosiup 3d

md physies geogebra physik vermsedens

Newest materials Best rated materials
Jarno Summa o o
October 5th, 2011 - 07:20

. Shared by jjmaki

0 comment(s)

Area of Circles 14 0

All materials on GeoGebraTube are under a Creative Common Attribution-Share
Alike License (www.geogebra.org/en/cc license/cc license.htm). This means
that you are allowed to use them for free and that you can create derivative work
if you give credit to the original author.
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o

The GeoGebra User Forum

The GeoGebra User Forum (www.geogebra.org/forum) was created to offer

additional support for the community of GeoGebra users. Created for teachers
and maintained by teachers, it is a platform to pose and answer questions related

to GeoGebra.

(@ Index page » GeoGebra User Forum - Moxzilla Firefox [=[®] =
Datei Bearbeiten Ansicht Chronik Lesezeichen Extras  Hilfe

‘Olndapage- GeoGebra User Farum | + | -
(€ )> hittp:/ fwww.geegebra.org/ferum/ - ||| M- Google Pl A
€ | O hutp: geog g IE ] J

GeaGebra

About  Download Help Materials Community
E login M Register HFAQ @ Search
GeoGebra User Forum
Last visit was: Itis currently Wed Oct 05, 2011 8:44 am [All times are UTC + 1 hour |

View unanswered posts | View active topics

».E

o]

English speaking users

Moderator: miir

@ Using GeoGebra 1972 | 10asg | WedOct0S, 20117:03am
=T e eyt sl Birgit Lachner 01
. ) : :
@ Technological Questions o azzg | WedOct05, 2011 8:03am
llation, dynamic braWiki, etc. rami »0
German speaking users. A
@ Bedienung von GeoGebra 5w 3g35 | TueOct04,20117:44 pm
Fragen rund um die Bedi von bra als Ei Birgit Lachner 40
@ Technische Fragen 422 1g2a | SetOct01,20117:28pm
llation. d i<ch usw. Birgit Lachner #0)
French speaking users/Utilisateurs francophones A
Francais Version 3.2 Tue Oct 04, 2011 3:30
ue 3 :30 pm
%) e el = A et sl G e et e 189 | saa | O
Moderators: Noel Lambert, miir
Francais Version 4.0 Mon Oct 03, 2011 6:33
‘ . lon ) 139 pm
(B2 | Messages relatifs & Ia version 4.0 188 1104 b
Moderators: Noel Lambert, miir -
@ Francais Version beta 4.2 (avec CAS) e 43 | TueOct04, 20116:01pm
Noel Lambert +0

»

The GeoGebra User Forum consists of several discussion boards in different
languages allowing users to post and answer their GeoGebra related questions

in their first language.
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Activity 19a: Creating Dynamic Worksheets

In this activity you will learn how to create a b
dynamic worksheet that illustrates how lower and
upper sums can be used to approximate the area “
between a function and the x-axis.

Preparations -

e Open a new GeoGebra window.
e Show the algebra view, input bar and
coordinate axes (View menu). . 0 B

Construction Steps

1 Enter the cubic polynomial f (x) = -0.5x> + 2x? - x + 1

2 o' | Create two points A and B on the x-axis

Hint: These points will determine the interval.

3 232 | Create a slider for the number n (interval 1 to 50; increment 1)

4 Create uppersum = uppersum[f, x(A), x(B), n]

Hint: x (») gives you the x-coordinate of point A.

5 Create lowersum = lowersum[f, x(A), x(B), n]

Insert dynamic text Upper Sum = and select uppersum from
6 ABC .

Objects

Insert dynamic text Lower Sum = and select lowersum from
7 ABC )

Objects
8 Calculate the difference diff = uppersum - lowersum

9 | ABC | Insertdynamic text Difference = and select diff from Objects

Hint: Fix the slider and the text using the Properties dialog.

Task: Use slider n in order to modify the number of rectangles used to calculate
the lower and upper sum. What happens to the difference of the upper and lower
sum (a) if n is small (b) if n is big?
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Reducing the Size of the GeoGebra Window

GeoGebra will export the algebra and graphics view into the dynamic figure of
the worksheet. In order to save space for explanations and tasks on the dynamic
worksheet you need to make the GeoGebra window smaller prior to the export.

If you don’t want to include the algebra view you need to hide it prior to the
export.

Move your figure (or the relevant section) to the upper left corner of the
graphics view using the * Move Graphics View tool (see left figure
below).

Hint: You might want to use tools ® Zoom in and ®\ Zoom out in order to
prepare your figure for the export process.

Reduce the size of the GeoGebra window by dragging its lower right
corner with the mouse (see right figure below).

Hint: The pointer will change its shape when hovering above an edge or
corner of the GeoGebra window.

Note: Although the interactive applet should fit on one screen and even leave
some space for text on the worksheet you need to make sure that it is big
enough to allow students manipulations and experiments.

Upload to GeoGebraTube

After adjusting the size of the GeoGebra window, you are now ready to export
the figure as a dynamic worksheet using the File menu.

File — Share...

Edit View Perspectives Options Tools Window Help

I:, MNew Window
MNew

&= open..
& Open Webpage ...

QOpen Recent L4
@ Save

Save As
;ﬁ} Share...

Export »
{&  Print Preview
[ close

The GeoGebraTube website opens automatically where you have to login
(or register if you do not have an account yet) before you are able to
continue your upload.
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YOU ARE HERE: GeoGebraTube - Upload material

l Search J

Creation progress: 0%

Upload material

Please login to GeoGebraTube in order to use this feature.

¢ Fill in the information for your students. If you want, you can also select to
show the toolbar, the inputbar or the menubar. Click Continue.

e Type a short explanation for other teachers, so that they are able to use
your materials, too. This information is not shown on the student
worksheet. Choose a target group and select tags that describe your
material to help others with searching.

e Finish your Upload with the Save button.

Your worksheet is now saved on GeoGebraTube where people are able to
like/dislike the material or write comments.

Exporting a Dynamic Worksheet to a Webpage (for Advanced Users)

Instead of uploading to GeoGebraTube it is possible to export your dynamic
worksheet to a webpage.
e Export — Dynamic Worksheet as Webpage
Hint: You could also use the key combination Ctrl — Shift — W.

Edit View Perspectives Options Tools Window Help
[ Newwindow
New
& open ..
[ openwebpage ..
Open Recent L4

Save

Sawve As ..

Share...

Yy @

Export ' [7* Dynamic Workshest as Webpage (html) ..
Graphics View as Picture (png, eps) ..
Graphics View as Animated GIF ..
Close [l Graphics View to Clipboard

Print Preview

G

Graphics View as PSTricks ..
Graphics View as PGRTIKZ ...

Graphics View as Asymptate
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Fill in the text fields in the appearing window in the Export as Webpage
Tab (title of the worksheet, name of the author, and date).

Type a short explanation of the dynamic figure into the text field Text
above the construction.

Enter tasks and directions for students into the text field Text below the
construction.

Click Export and save your dynamic worksheet.

Hint: GeoGebra will create several files which always need to stay
together in order to maintain the functionality of the dynamic worksheet.
We recommend creation of a new folder (e.g. Dynamic_Worksheets)
within the GeoGebra_Introduction folder prior to saving your dynamic
worksheet.

Tips and Tricks for Creating Dynamic Worksheets

After saving the dynamic worksheet it will be automatically opened up in
your web browser. Check the text you inserted as well as the functionality
of the interactive applet. If you want to change your dynamic worksheet go
back to the GeoGebra file and make your changes to the figure. Export
the figure again (you can use the same file name to overwrite the old
worksheet) in order to apply your changes.

Hint: You can change the text of the dynamic worksheet in the same way.
GeoGebra automatically saves your entries in the export window for
dynamic worksheets. If you want to make changes to your figure while
filling in the export dialog you can just close it and continue later on.

Make sure your applet is not too big. Your students shouldn’t have to
scroll between the tasks and the figure because this makes learning more
difficult.

Your dynamic worksheet should fit on one screen. If you want to include
more than 3 tasks you should consider creation of another worksheet that
includes the same dynamic figure but different tasks.
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Activity 19b: Enhancing Dynamic Worksheets

The export dialog window for Export as Webpage consists of two tabs: General
and Advanced. In the last activity you used tab General in order to add
explanations, tasks and directions to the dynamic figure prior to the export. You
will now learn how to enhance your dynamic worksheet by including different
features in the interactive figure using the tab Advanced.

Dynamic Worksheet Export (html) PG

'._\:\).\\ s
e I: i

Upload to GeoGebraTube Expoit as Webpage

Title

Author: Date:

General | Advanced

Functionality User Interface
Enable Right Click, Zooming and Keyboard Editing Show Menubar Enable Save, Print & Undo
Enable Dragging of Labels Show Toolbar Show Toolbar Help
Show Icon to Reset Construction Show Inputbar |V Allow Rescaling

Double Click Opens GeoGebra Window
Buiton to Open GeoGebra Window

7| Use Browser for JavaScript scripts Width: Height:
Files
Include HTMLS File: htmi -

Include jar Files

V| Remove Line Breaks

| @) Help | | Export | | Cancel

Functionality

e Enable right click, zooming and keyboard editing features: Your students
will be able to right click objects or the graphics view in order to access the
features of the context menu (e.g. show / hide object or label, trace on /
off, Properties dialog). It is also possible to use the common keyboard
shortcuts.

e Enable dragging of labels: By selecting this feature students are able to
drag labels of points or objects.

e Show icon to reset construction: A reset icon is displayed in the upper
right corner of the interactive applet allowing your students to reset the
interactive figure to its initial state.

¢ Double click opens application window: Your students will be able to open
a full GeoGebra window by double clicking the interactive applet.

e Button to open application window: A button is displayed to open the
GeoGebra window directly.

e Use Browser for JavaScript Scripts: JavaScipt Scripts are enabled. This
allows your browser to show your construction properly.
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User Interface

Files

Task

Show menubar: The menubar is displayed within the interactive applet.
Enable save, print & undo: It is possible to provide your students features
for saving, printing and undoing the construction.

Show toolbar: The toolbar is displayed within the interactive applet
allowing your students to use the geometry tools.

Show toolbar help: In combination with the toolbar, you can also display
the toolbar help within the interactive applet. If you want your students to
use geometry tools they can use the toolbar help in order to find out how
to operate the different tools on their own.

Show inputbar: The input bar is displayed at the bottom of the interactive
applet allowing your students to use algebraic input and commands for
their explorations.

Allow rescaling: Affects the behavior of zooming within the browser, in
order that the construction is rescaled, too.

Width and height of the interactive applet: You can modify the width and
height of the interactive applet.

Note: If you reduce the size of the applet important parts of the dynamic
worksheets might be invisible for your students.

Hint: If you include the menubar, toolbar, or input bar you might want to
adjust the height of the interactive applet.

Include HTML 5: Includes HTML 5 into your exported webpage.

Include * jar files: Creates not only the html file, but also the *.jar files.
Remove Line Breaks: removes line breaks if there are any

File-Dropdown: You can choose if the export-file is html, MediaWiki,
GoogleGadget or Moodle.

Single File: A dynamic webpage will be created using a single file.

Single File (Tabs): More than one worksheet can be displayed in the
browser. Your students are able to navigate between the different tasks by
using tabs.

Linked Files: Creates linked dynamic worksheets and provides Next and
Back buttons to work on more than one exercise.

Hint: For creating several interactive applets it is necessary to create more
than one construction using File - New Window or Ctrl-N.

Use the dynamic figure you created in activity 18 and export it as an enhanced
dynamic worksheet. Use the Advanced tab to try out different options and check
how the applet of your dynamic worksheet is changed accordingly.
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Activity 19c: Providing Dynamic Worksheets to Students

You can provide your dynamic worksheets in several ways to your students.
However, in all cases it is very important to keep all the files together which were
created during the export process.

Note: The files created have different file name extensions (.ggb, .html, jar). If
one of these files is missing your dynamic worksheet won’t function any more.

Local Storage Device

Copy all files into the same folder before saving this folder on a local storage
device (e.g. flash drive, CD). Have your students copy the whole folder on their
computers. Your students will have to open the file with the name extension .html
in their Internet browser.
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13.

Practice Block IV

This practice block consists of a pool of activities to practice exporting GeoGebra
constructions as picture files and creating dynamic worksheets. Activities of two
different difficulty levels are available: Basic tasks and Advanced tasks. You can
pick tasks of your interest and work on them either on your own or together with
a colleague.

Tips and Tricks

For each of these activities, open a new GeoGebra file. Check prior to
beginning the activity if you need to show or hide the algebra view, input
bar and coordinate axes.

You might want to save your files before you start a new activity.

Don’t forget about the Undo and Redo buttons in case you make a
mistake.

Frequently use the Move tool in order to check your dynamic figures (e.g.
did you create any unnecessary objects, are sliders and text fixed so they
can’t be moved accidentally).

Make sure, you know how to use corresponding geometry tools before
you begin the construction. If you don’t know how to operate a certain tool,
activate it and read the toolbar help.

Make sure you know the syntax to enter algebraic expressions and
functions. Read through the Tips and Tricks section in the beginning of
topic Basic Algebraic Input, Commands, and Functions. If you have
trouble, ask colleagues for help.

Carefully check algebraic input before hitting the Enter key. If an error
message appears, read it! It might help you to fix the problem.

Make sure to try out your dynamic worksheets in order to check for
mistakes and fix them if necessary.

Always keep the files for a dynamic worksheet together in a folder (files
with the extensions .ggb, .html, jar).

You can save several dynamic worksheets into the same folder.

Note: The files with the extension .jar are just created once in this folder. If
you want to provide one of the dynamic worksheets to your students you
need to copy the jar-files in addition to the corresponding ggb- and html-
files.

If you have questions, please ask a colleague before you address the
presenter or assistant(s).
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Activity IV.a: Area Relations of Similar Geometric Figures

Classification: Basic task

In this activity you are going to use the following tools and algebraic input. Make
sure you know how to use each tool before you begin.

a =2 I_» Regular Polygon

Segment With Given Length New! Q Move

Task

In this activity you will recreate the following worksheet for your students. It
allows them to discover the special relationship between the area of squares
whose side lengths are a, a/2, and 2a.

Area Relations

1. Measure the side length of the three squares below. Compare the side
length of the blue square to the side lengths of the red and green squares.
Which relation can you find?

2. Calculate the areas of the three squares. Compare the area of the blue
square to the areas of the red and green squares. Which relation can you
find?

3. Formulate a conjecture that compares the side length and area of the blue
square to these of the red and green squares.

4. Try to proof your conjecture.

Hints: Assume that the side length of the blue square is a and calculate
the areas of the corresponding squares.

D c D, Cy
A B

Dy Cy

Aq B, Ay B,
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Construction Steps

1. Start your construction in GeoGebra by creating the number a = 2.

2. Construct the blue square starting with Segment with given length a.
Then, use the two endpoints of this segment to create a regular polygon
with 4 vertices.

3. In the same way construct the red square with side length a/2 and the
green square with side length 2a.

4. Rename the vertices and change the properties of the squares (e.g. color,
line thickness).

5. Prepare the GeoGebra window for the export of the graphics view as a
picture (e.g. rearrange the squares, reduce the size of the GeoGebra
window).

6. Export the graphics view as a picture and save your picture file.

Hint: Since your students are supposed to measure the side length of the
squares you should not change the scale of the picture!

7. Open a word processing document and type in the heading and tasks of
the worksheet.

8. Insert the picture of the squares into the worksheet.

Hint: Make a printout of the worksheet and try it out by measuring the side
lengths of the squares.
Challenge 1

Create similar examples for different geometric shapes (e.g. circle with given
radius, equilateral triangle, rectangle). For which of these shapes do the same
relations between the length of the given side (radius) and the resulting area
apply? Try to find an explanation for this relationship between the given length
and the area of the figure.

Challenge 2

Create a dynamic worksheet based on your construction that helps your students
to generalize their conjecture about the relationship between the side length and
the area of such geometric shapes (for example, see A_4a_Area_Circles.html).

Relationship Circle Areas

Below you can see three circles with the radii r, r/2, and 2r.
Solve the tasks and write down your answers on paper.

r=4
e
Task 1
Calculate the areas of the circles forr=1.
Come up with a conjecture about the
relationship between the length of the radius
and the area of the three circles.

Task 2

Use the slider to change the radius r. Again,
calculate the areas of the circles and check
your conjecture about the relationship.

Task3
Proof that your conjecture is true for all circles
whose radii arer, /2, and 2 1.

Hint: Express the areas of these circles and
compare them.
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Activity IV.b: Visualizing the Angle Sum in a Triangle

Classification: Basic task

In this activity you are going to use the following tools. Make sure you know how
to use each tool before you begin.

.. . Rotate Object Around Point By
| _'_‘:‘ -
. Polygon 4 Angle
4 Angle [y Move
as?  Slider ABC Insert Text
. Midpoint
Construction Steps S 55‘;’25 arprymEe

1. Create a triangle ABC.

Hint: Use counterclockwise orientation.
2. Create the angles a, 8, and y of triangle ABC.
3. Set the number of decimal places to 0
(Options menu).
Create sliders 6 and ¢ with the settings angle
(type); 0° to 1807 (interval); 10° (increment).
Create midpoint D of segment AC and midpoint E of segment AB.
Rotate the triangle around point D by angle 6 (setting clockwise).
Rotate the triangle around point E by angle ¢ (setting counterclockwise).
Move both sliders to show 180° before you create the angles { (A’C'B’)
and n (C1B"“A").
Enhance your construction using the properties dialog.
Hint: Congruent angles should have the same color.

B

© N O

©

Challenge 1

Insert dynamic text showing that the interior angles add up to 180°.

Hint: Create dynamic text for the interior angles (e.g. ¢ = and select a from
Objects), calculate the angle sum using sum = a + B + y and insert the sum
as a dynamic text.

Match colors of corresponding angles and text. Fix the text in the graphics view.

Challenge 2

Export the figure to a dynamic worksheet. Come up with instructions that guide
your students towards discovering the angle sum in a triangle. Have them check
their conjecture using the provided worksheet.
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Activity IV.c: Visualizing Integer Addition on the Number Line

Classification: Advanced task

In this activity you can either use the following tools or corresponding commands.
Make sure you know how to use them before you begin.

Slider . Segment Between Two Points

New Point ABC  Insert Text

Vector [¥]% Checkbox to Show/Hide Objects  New!
Move

Construction Steps

1.

2.

o s

Open a new GeoGebra window and hide the algebra view. Set the
labeling option to All new objects (Options menu).

Open the Properties dialog for the Graphics View. On tab yAxis, uncheck
Show yAxis. On tab xAxis, set the distance of tick marks to 1 by checking
the box Distance and entering 1 into the text field. On tab Basic set the
minimum of the x-Axis to -21 and the maximum to 21.

Create sliders a and b (interval -10 to 10; increment 1). Show the value of
the sliders instead of their names (Properties dialog).

Create pointsa = (0 , 1)andB = A + (a , 0).

Create vector u = Vector[A, B] which has the length a.

Create pointsc = B + (0 , 1)andD = C + (b , 0) as well as
vector v = Vector[C , D] which has the length b.

Create pointR = (x(D) , 0).

Hint: x (D) gives you the x-coordinate of point D. Thus, point R shows the
result of the addition.

Create point z = (0, 0) as well as the following segments:

g = Segment[Z, A],h = Segment[B, C],1 = Segment[D, R].
Use the Properties dialog to enhance your construction (e.g. change color,
line style, fix sliders, hide labels).

! I
L N

-20-19-18-17-16-15-14-13-12-11-10 -9 -8 -7 -6 -5 -4 -3 -2 -1 0 123456 78 91011121314151617 181920
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Challenge 1

Enhance your interactive figure by inserting dynamic text that displays the
corresponding addition problem.
10. Calculate the result of the addition problem: r = a + b
11.In order to display the parts of the addition problem in different colors you
need to insert the dynamic text step by step.
a. Insert text1: Select a from Objects
b. Insert text2: +
c. Insert text3: Select b from Objects
d. Insert text4: =
e. Insert text5: Select r from Objects
12.Match the color of text1, text3, and text5 with the color of the
corresponding sliders and point R. Hide the labels of the sliders and fix the
text (Properties dialog).
13. Export the interactive figure as a dynamic worksheet.

T T S S S A S A L A S G e e e e e e e e S e S

-20-19-18-17-16-15-14-13-12-11-10 -9 8 -7 6 -5 4 -3 2-1 0 1 2 3 4 56 7 8 9 10111213 14151617 181920

Challenge 2

Insert a checkbox into the graphics view that allows you to show or hide the
result of the addition problem (text5, point R, and segment /).
14. Activate tool ¥° Checkbox to show and hide objects.
15. Click on the graphics view next to the result of the addition problem.
16.Enter Show result into the Caption text field.
17.From the drop down menu successively select all objects whose visibility
should be controlled by the checkbox (text5, point R, and segment /).
18.Click Apply to create the checkbox.
19.In Move mode check and uncheck the checkbox to try out if all three
objects can be hidden / shown.
20.Fix the checkbox so it can’t be moved accidentally any more (Properties
dialog).
21.Export this new interactive figure as a dynamic worksheet.
Hint: You might want to use a different name for this worksheet.

-10 + 5 = ] Show result

-20-19-18-17-16-15-14-13-12-11-10 9 -8 -7 -6 -5 -4 -3 -2 -1 O 12345 67 8 91011121314151617 181920
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Activity IV.d: Creating a ‘Tangram’ Puzzle

Classification: Advanced task

In this activity you will create the ‘Tangram’ puzzle a
shown at the right hand side. It consists of 7
geometric shapes which can all be constructed using a
the side length a (see A_4d tangram_puzzle.html).

For these constructions you will need a selection of
geometry tools. Please read through the following 2
hints before you actually start to create the geometric )
shapes. .

a

1. Enter the number a = 6. It will provide a basis for the construction of all
triangles and quadrilaterals necessary for a ‘Tangram’ puzzle.
2. Try to figure out the side lengths of the geometric shapes.
Hint: In some cases you might want to look at the diagonals or height.
Their lengths can be expressed more easily using the variable a than the
lengths of the corresponding sides.
3. Begin each of the geometric figures using a segment with given length.
This will allow you to drag and rotate the figure later on.
4. Construction hints:
a. If the height of a right triangle is half the length of the hypotenuse
you might want to use the theorem of Thales for the construction
(see practice block 1).
b. If you know the legs of a right triangle you might want to construct it
similar to the square construction presented earlier.
c. For constructing a square using its diagonals, it is helpful to know
that they are perpendicular and bisect each other.
d. For constructing the parallelogram it is helpful to know the size of
the acute angle.
5. Check your construction by trying out if you can manage to create a
square with side length a using all figures.

Challenge 1: Arrange the geometric shapes arbitrarily around the edges of the
interactive applet. Export the figure to a dynamic worksheet and add an
explanation for your students (see dynamic worksheet
A 4d tangram puzzle.html).

Challenge 2: With these geometric shapes other figures than a
square can be created as well (see A_4d _tangram_puzzle cat.html).
Search the Internet for a “Tangram’ figure other than a square (e.g.
A _4d tangram cat.png) and import this figure into the graphics view.
Export the GeoGebra construction again using a different name and
different instructions.
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